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 المرحلة الثانية 

 الدراسة الصباحية والمسائية 

 

 آمنة هيثم    لهيب كريم 
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 تحديد الاسم

  الدخول الى النظام -1

1-start→All programs→Microsoft access 2016 

2-R.C/Access Icon → open  

 انشاء او تكوين قاعدة جديدة  -2

File→New→blank data base→file name→                  →create 

 objects (access)تظهر نافذة تكوين عناصر  -3

Tables, Queries, Forms, Reports, Pages, Macros, Modules  

 Tablesسوف نبدأ بأهم عنصر من عناصر النظام وهو 

 -الجداول: هنالك ثلاث طرق لتكوين  بالعمل،بعدها ننتقل الى نافذة أخرى للبدأ  -4

1-create table in Design view 

2- create table by using wizard  

3- create table by entering data 

 نبدأ بالطريقة الثالثة وهي طريقة ادخال البيانات مباشرة. 

 ضغط عليها تظهر لنا نافذة الجدول.بعد ال

        كون الجدول التالي                             -: 1مثال 
city average born stname St/up 

Kut 80 1998 Ahmed 1 

Basra 75 1997 Ban 2 

Mosul 66 2000 Noor 3 

Baghdad 70 2001 Ali 4 

Table1: Table 

                            

 

 

 

 

 

  Field 3 Field 2 Field 1 
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R.C→ Rename Colum   
  على العمود                            

yes Default name 

NO 

ونكتب مكانه اسم الحقل في الجدول                               نبدأ بتغيير اسم الحقل    

 

Field 1→ No, Field→stname 

 بعدها نبدأ بإدخال البيانات وحسب الحقول ثم نقوم بأغلاق النافذة ويتم السؤال حول خزن الجدول ام لا  

تخزن باسم جديد او بالاسم الافتراضي                    الذي توفره الحاسبة وتظهر     نختار      Yes/No   

   لعدم وجود ربط للجداول حاليا        لا نختار رسالة تكوين                    

 

• Field Proprieties 

 للعمود     R.Cنكمل فعاليات العمود نقصد    

 ترتيب تصاعدي للبيانات سواء كانت رقمية أم عددية 

 ترتيب تنازلي للبيانات سواء كانت رقمية ام عددية  

 تغيير عرض العمود  

 إضافة عمود  

 حذف عمود 

 إخفاء عمود  

 لأرجاع العمود المخفي      

 

 لتثبيت العمود    

 لألغاء تثبيت العمود     

 

• Font Proprieties 

 التغيرات الحاصلة على الخط في العمود  

                                                  Format→Fontقائمة  

 يتم التحكم بالآتي 

 Font        Font stile          Size           Color   

الخط      نوع الخط لون الخط      حجم الخط       نمط   

 

Primary key 

1-sort Ascending 

2-sort Descending 

3-column width 

4-insert column 

5-Delete column 

6-Hide column 

7- Unhide column 

8- Freeze Field 

9- Unfreeze All Field 
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• Background  Color 

 لتغيير لون خلفية الجدول  

Format→Data sheet formatting→Background color→اختيار اللون    
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 على الحقل
 اختيار الصورة

 create table in Design viewتكوين الجدول بطريقة التصميم )الطريقة الثالثة(  -5

 بعد اختيار الطريقة تظهر النافذة التالية المكونة من الحقول التالية: 

Field Name, data type, Description                                                   

 نملأ اسم الحقل   -1
 data typeنحدد نوع البيانات في  -2

Text    نصية 

Number    رقمية 

Data/Time    وقت وتاريخ 

Currency   عملة 

Auto Number   ترقيم اوتوماتيكي 

Yes/No    حقل منطقي 

OLE Object    للصورة 

General   في اسفل الحقل تمثل خصائص البيانات 

Field size     حجم الحقل 

Caption     وضع اسم اخر للحقل 

Validation text     رسالة تحذير لمدخل البيانات عند عدم تحقق الشرط 

   OLE objectللحصول على الصورة نختار نوع البيانات 

   Required→yesوفي اسفل النافذة 

              R.C → insert object → object type → Microsoft word picture→ 

ok → insert → clipart →                          →GO                                           

 

 

 للقاعدة  (PASSWORD)للحصول على كلمة سر  -6

 تكوين قاعدة بيانات جديدة -1

2- File → Info→Encrypt with password     من شريط القوائم 

 تظهر نافذة 
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 إلغاء كلمة السر   -3

• File → Open→Browse→one click on the Database file→ 

ثم ندخل كلمة السر ونفتح   Open Exclusiveثم نختار   Openنفتح السهم الذي بجانب كلمة 

 File → Info→Decrypt Database   قاعدة البيانات
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  Import tableإستيراد الجداول   -7

 دة المطلوب توريد الجداول اليها  فتح القاع-1 •

• External Data tab → in the Import & Link group → click New Data 

Source → From Database → Access . 

 

 

الجدول او الجداول منها ثم نضغط   إستيراد ونحدد القاعدة المطلوب  importتظهر نافذة  •

import  
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 جداول منها نختار منها قاعدة البيانات التي نريد إستيراد ال  File Openتظهر نافذة   •

 

 ok نضغط على  •

 

 نختار الجدول أو الجداول المطلوب إستيرادها  import objectتظهر نافذة  •
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 saved Importsثم نضغط على    ok   نضغط على  •

 Export table 1تصدير الجداول  -8

 أخرى  بنفس طريقة الإستيراد نقوم بتصدير الجدول أو الجداول من قاعدة بيانات إلى •
 

 

دير ستظهر لنا آخر نافذة  نقوم من خلالها إختيار طريقة تصدير  بعد إتمام خطوات االتص •

 الجدول مع البيانات أو بدونها وكما في الشكل أدناه 
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9- Primary Key   (PK) :- 

 Primary Key (PK)  الأساسي )الحقل الرابط(مفتاح ال •

هو عبارة عن حقل او اكثر من حقل في الجدول يشمل على بيانات لا يسمح بتكرارها  

 مثل رقم الحساب, رقم السيارة ورقم الجنسية وغيرها... 

للربط بين الجداول ويستخدم للبحث عن السجلات ومن   حقل ويستخدم هذا ال

   -خصائصه:

لا يسمح بتكرار البيانات في الحقل  -1  

Access 2 حجم حقل المفتاح الرئيسي تؤثر على سرعة العمليات في برنامج الـ -  

 Create PK تكوين المفتاح الرئيسي  •

وعند خزنه يسأل مساعد الأكسس     Design viewبطريقة الــ عند تكوين الجدول  .1

 Yesاو    Noفيكون الجواب  عن تكوين حقل المفتاح الرئيسي 

 فيقوم بتكوين حقل المفتاح الرئيسي تلقائيا   
 

 اما إذا كان الجدول مخزون سابقا  بدون حقل أساسي فلأضافه الحقل الأساسي   .2

  Design view نضع الجدول على طريقة ➢

من  ل ونؤشرعلى ايقونة المفتاح الرئيسي نضع المؤشر بجانب اسم الحق ➢

   نختار ايقونة الـ    Table Design تبويب الـ
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 -: Tables  Relationshipsالجداول  ربط -10

 

 Connect table with Fieldحقل من جدول اخر بربط جدول  •

 Design view  عند فتح الجدول بطريقة .1

 Field viewنحدد اسم الحقل  .2

 نختار نوع البيانات  .3

Data type→ look up wizard 

 

 

 

 

 

 

 

 

 وفيها خيارين :  Look up wizard فتظهر نافذة 

  لخيار الأول  ا .1

معناها لدينا جدول مسبقا   

ونقوم بربطه بالجدول  

 الرئيسي  

 

 

 

 

 

 

 

I want 
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نختار الجدول الذي سوف نقوم بربطه مع الحقل  

 Nextوبعدها نضغط على 

 

 

 

 

 

 

سوف تظهر لنا حقول الجدول الذي تم إختياره  

 Nextسابقا . نختار منه الحقول ثم 

 

 

 

 

زر  لإضافة الحقول بشكل حقل حقل نضغط 

 

 

 

 

 

 لإضافة الحقول مرة واحدة نضغط زر  
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تظهر نافذة لإختيار تسلسل الحقول وترتيب بيانات  

  Nextالحقول بشكل تصاعدي أو تنازلي  ثم 

 

 

 

 

وبياناته    الذي قمنا بربطه تظهر حقول الجدول

    بالشكل النهائي

 

  

 

 

 تظهر لنا النافذة الآتية والتي تتضمن خيارين 

: يسمح لنا بحذف    Cascade Deleteالأول 

 الحقل الذي تم ربطه بالجدول بعد الربط 

: لا يسمح لنا بحذف   Restrict Deleteالثاني 

 الحقل الذي تم ربطه بالجدول بعد الربط 

  

   Finishثم نضغط على 

 

  Finishبعد الإنتهاء والضغط على  

   Yes تظهر نافذة حفظ العمل نضغط 

 

لرئيسي ومن ضمنه حقل الذي تم ربطه بالجدول الآخر  تظهر لنا نافذة تحتوي على الجدول ا

 كالآتي 
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  الخيار الثاني  .2

معناه نقوم بتكوين جدول  

جديد باختيار عدد الأعمدة  

وملأ البيانات وتسمية  

 الجدول 

 تظهر لنا النافذة التالية  

 

 

 

نتبع نفس الخطوات السابقة في  

خلق  مع ملاحظة    1الفقرة  

جدول جديد بدل استخدام جدول  

 موجود سابقا 

 

 

I will 

للجدول الذي   Fieldعدد الـ 

 ستخلقه للربط

 ملئ الجدول بالمعلومات
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سوف     Nextبعد الضغط على 

تظهر هذه النافذة بعدد الحقول  

 وأسماءهم  

 Nextبعدها نضغط 

 

 

 

 

 

نلاحظ هنا إسم الحقل الذي تم ربطه  

 بالجدول 
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على   الضغط  قد     finishعند  يكون 

بالحقل   الجدول وربطه  بناء  إنتهينا من 

أنا   بما  المثال  وفي   . الأول  للجدول 

ربطنا حقل الاسم ومع الجدول فنلاحظ  

عند الضغط على السهم الموجود بجانب  

بخلقه   قمنا  الذي  الجدول  ظهور  الإسم 

 الربط  أثناء

 

 

 

 - :  Connect Table with another Table  بجدول آخر  ربط جداول  •

 لربط جدولين بعلاقة معينة نتبع الخطوات الآتية   

في جدول الطالب ورقم     PKونحدد رقم الطالب   Teacherو  Studentجدولين مثلا جدولي   ي  ننش .1

 في جدول المعلم    PKالمعلم

 ( في جدول الطالب  Foreign keyملاحظة سيكون رقم المعلم هو )       

Foreign key : -  هو( عبارة عن عمودField  )   يكونPK    في جدول آخر 

 - :   Teacherجدول الـ  
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 - :  Studentجدول الـ   

 

 بعد تكوين الجداول يجب غلقها قبل البدء بعملية الربط   -ملاحظة مهمة :

نضغط على    Database Toolsنذهب إلى تبويب   .2

Relationships    

لنا مربع حوار نختار منه الجداول المطلوب   يظهر  .3

 ربطها  

أو نقرتين مزدوجة على إسم    Addأما بالضغط على  

 الجدول  

 

 

 

 

 

نضغط ضغطة   لجدولين  منفصلتين لتين ستظهر نافذ

( من جدول الـ   TeNo)   PKمستمرة على حقل الـ

Teacher  ـ ونقوم بسحب المؤشر إلى حقل الFK  

(TeNo  نفسه ولكن في جدول الطالب ) 

 

 

 

 ستظهر نافذة التي من خلالها نستطيع   .4

  تحديد الحقول التي يمكن الربط بها

 وفيها خيار  

 هذا الخيار يفعل لنا الخيارين الآخرين في النافذة

 Fieldيسمح لنا بتحديث الـ 
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 نقوم بتفعيل هذه الخيارات ليسمح لنا بتحديث السجلات أو الأعمدة  

 مع الجدول الآخر   على سبيل المثال عند حذف سجل معلم معين سوف يحذف الإرتباط هذا السجل

تظهر لنا النافذة     Createالضغط على  عند .5

   - الآتية :

 نلاحظ أن العلاقة بين الجدولين هي  

(1 -M)     one - to – many      والسبب أن

المعلم الواحد يستطيع تدريس طلاب عديدين 

 )معلم واحد لأكثر من طالب( 

 

 لخرن العمل   Saveثم نضغط أيقونة الـ 

 

 

 نقوم بفتح الجدولين التي تم ربطهما  ونقوم بملئ البيانات في الجدولين الذي تم إنشاءهما مسبقا  

 

 

 

 

 

 

 

في جدول الطالب يجب أن تكون    FKوالذي هو الـ   TeNoعند ملئ  حقل الـ   - ملاحظة مهمة :

 في جدول المعلم     PKالذي هو الـ    TeNoبياناته مأخوذة من حقل الـ  
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 معلم  بجانب كل سجل من سجلات ال  + عند الرجوع إلى جدول الـمعلم نلاحظ ظهور علامات الـ 

 

 

 

 

 

 

 

 

 

 

 
 

 

   -:  Queriesالإستعلامات  -11
 

إن الاستعلامات هي طريقة للبحث عن البيانات وتجميعها من جدول واحد أو أكثر. تشغيل استعلام  

، فإنك تحدد  Access يشبه طرح سؤال تفصيلي لقاعدة البيانات الخاصة بك. عند إنشاء استعلام في

 .  ر على البيانات التي تريدها بالضبطشروط بحث معينة للعثو 

 

 ( من جدول واحد Queriesإنشاء إستعلام ) •

 Queries Wizardطريقة  .1
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من  الموجود    Queries Wizardنضغط على  

قائمة     Createتبويب تظهر   New  سوف 

Queries  نختار     إختيارات ا اربع  لهSimple 

Queries Wizard 

 

 

 

 

 

 

 

سوف تظهر لنا نافذة نختار     okعند الضغط على  

للإستعلام   إضافتها  المراد  الأعمدة  منها 

(Queries)   ثم أضغطNext 

 

 

 

 

 

 

 لدينا خياران 

يظهر لنا نتيجة     Open the Queryالأول هو  

الإستعلام مباشرة والذي هو عبارةعن عرض  

التي تم إختياراها   , وكأننا نطلب منه    الأعمدة 

 عرض للأعمدة المختارة فقط من الجدول 
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الإستعلام   ناتج  تبين  النافذة  هذه 

السابق  للحقول التي تم إختيارها 

 ( الإستعلام   , TNameفي 

TDep  ) 

 

 

 Modify theأما الخيار الثاني  

Query Design  

الإستعلام   يعرض  مجرد 

(Query  بطريقة الـ )Design 

View   . 

 

 

 

 

 

 

 

الـ   الرياضية على  العمليات  إجراء  يمكن  أخرى  بعبارة  رقمية  أعمدة  يحتوي على  الجدول  كان  إذا 

Field    مثل الجمع والطرح والقسمة وحساب المعدل سيكون الـQueries Wizard : كالآتي- 

 

 

 

 

 Queriesثم    Createلضغط على  بعد ا

Wizard    ضمنها من  الأعمدة  وإختيار 

   -الأعمدة الرقمية تضهر لنا النافذة الآتية :

 

 

 يظهر لنا خياران هما  

Detail      وSummary  
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إختيار   نافذة       Detailعند  لنا  ستظهر 

 الحقول الغير رقمية نفسها كما الآتي : 

 

 

 

 

 

 

 

 

 

    Summaryأما عند إختيار 

الأعمدة   الخيار  هذا  من خلال  أحدد  سوف 

التي أريد إجراء عمليات رياضية عليها مع  

ملاحظة أن هذا الإجراء سوف يطبق على  

  (.Number Fieldالأعمدة الرقمية فقط ) 

 

 

على      Summary Optionsنضغط 

المراد      Functions  بإختيار  الـ    ونقوم  

 تنفيذها لكل عمود رقمي  

 

 

 

 نختار فقط العمود الرقمي 
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التي تطبق    Functionsتظهر لنا الـ  

ا تم     Fieldلـعلى  الذي  الرقمي 

 - :  Functionوهذه الـ إختياره

1.  Sum :-    جمع بعملية  يقوم 

 الرقمي  Fieldحقول للـال

2.  Avg :-    المعدل بحساب  يقوم 

 Fieldللـ

3. Min  :-   أصغر قيمة موجودة في

 Fieldالـ 

4. Max  : -    في قيمة موجودة  أكبر 

 Fieldالـ 

5. Count records in Table   : -  

  الإختيار الأخير الموجود بجانب العمليات الرياضية  والذي يقوم بحساب عدد الحقول الموجودة

 . ياضية والتي تمت عليها العمليات الر

 

 وكما موضح  Queryيظهر لنا الـ    Finishعند الضغط 

 

 

 

 Table Studentهو التي أجريت عليه العمليات  Fieldـ  حيث الجدول المأخوذة منه ال
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 Queries Designطريقة  .2

 

 " على الشريط، وحدد موقع مجموعة الاستعلامات. Creatحدد علامة التبويب " .1

 الأمر "تصميم الاستعلام". انقر فوق  .2

 

 
 
 

 Queries إلى طريقة عرض " Access سيتحول .3

Design   " الحوار  مربع  في   ."Show Table  "

الذي تريد تشغيل استعلام   الذي يظهر، حدد الجدول 

عليه. نحن نجري استعلامًا على عملائنا، لذلك سنحدد  

 جدول العملاء. 

  

 
 

 إغلاق. انقر فوق إضافة، ثم انقر فوق  .4

 

 

 

سيظهر الجدول المحدد كنافذة صغيرة في جزء    .5

"ER مزدوجًا نقرًا  انقر  الجدول،  نافذة  في   ."

في   تضمينها  تريد  التي  الحقول  أسماء  فوق 

الاستعلام. ستتم إضافتهم إلى شبكة التصميم في  

 الجزء السفلي من الشاشة. 

إلى    ERالـ    - :ظة  ملاح  مختصر   Entityهو 

Relation Diagram     وهو عبارة عن مخطط

للجدول والذي يحتوي على إسم الجدول وأسماء  

 التابعة للجدول .   Fieldالـ  

 

 
 

 

https://1.bp.blogspot.com/-FCXH1KWQTHA/Xzmwfsp5GeI/AAAAAAAAHso/2b4eiEK3z-MP3hTFOB0GzjemLGx8yIeKwCLcBGAsYHQ/s1600/image2.webp
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قم بتعيين معايير البحث بالنقر فوق الخلية الموجودة في الصف المعايير: لكل حقل تريد تصفيته.   .6

تؤدي كتابة المعايير في أكثر من حقل واحد في الصف المعايير: إلى تعيين الاستعلام الخاص بك  

 تحتاج إلى  لتضمين النتائج التي تفي بجميع المعايير فقط. إذا أردت تعيين معايير متعددة ولكنك لا

تلبية السجلات المعروضة في نتائجك جميعاً، فاكتب المعايير الأولى في الصف المعايير: والمعايير  

 الإضافية في أو: الصف والصفوف الموجودة أسفله.  

 

 

نريد   مثالنا،  الثالثة  في  للمرحلة  الطلاب  أسماء 

    StName , StClass. نحدد عمودي الـ    فقط

  Criteria  ونكتب الشرط في خانة

 

 

 

  

 

 

أسماء الطلاب للمرحلة الثالثة  في مثالنا، نريد  

. نحدد عمودي  70فقط  أو درجاتهم أكبر من  

    StName , StClass , Degreeالـ  

خانة   في  الأول  الشرط       Criteriaونكتب 

 .     Orوالشرط الثاني في خانة  
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 ( Formالنموذج  ) -12

 , وتسهيل إدخال البيانات .   عبارة عن واجهات لإظهار البيانات بشكل أنيق

 هناك طريقتان للنموذج  

 ”Create Form by Wizard“  الطريقة الأولى

  ”Create Form in Design View“الطريقة الثانية  

• “Create Form by Wizard on Table or Query” 

 لجدول او استعلام نتبع الخطوات التالية  formلانشاء 

1. Create form on table : - 

 الجدول الاتي : لقد قمنا مسبقا بانشاء 

  

 

 

 

 على هذا الجدول نتبع الخطوات الاتية    {form}لانشاء نموذج 

       Create                  form             form wizard 
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 form wizardستظهر لنا نافذه 

ثم نضغط   والحقول  الجدول  منها  نختار 

next 

 

 

 

 

 

 

 

 

 

 

تظهر نافذه تطلب تحديد شكل النموذج نحدد  

الشكل المطلوب بشكل اعمدة او صفوف او  

  data sheetمتساوي او 

 nextثم نضغط  
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للنموذج   عنوان  تطلب  نافذه  ستظهر 

 finshنعطي عنوان ثم نضغط 

 

 

 

 

 

 عمودي  column ستظهر نافذه  النموذج بطريقة    •

 

 

 

 

 
 
 

 
  بشكل جدولي أي - : tabularنافذه  النموذج بطريقة   •
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 datasheetنافذه  النموذج بطريقة   •

 

   justifiedنافذه  النموذج بطريقة   •

 

 

ممكن تغيير تصميم النموذج من   •

النموذج   الضغط على اسم  خلال 

right click 

 design viewثم اختار 
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 تظهر لنا نافذه من خلالها يمكن تغيير الطول العرض الارتفاع او حتى التصميم والوانه  ايضا   •

 

 

 

 

 

 

 

 

 

 

 

 

 

 form designفي   themesممكن تغيير الوان واشكال النموذجمن خلال تبويب  •

 

 

  

 

  

 

 

 

 

 

 

 هذا الجزء ممكن من خلاله اضافة 
Label ,button, combo box, 
radio box ,check button….. 

 

لاضافة عنوان جديد او شعار او 

 عنوان الصفحات او وقت وتاريخ
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 لتغيير لون الخلفية   •

  right clickط غنحدد الجزء المراد تغيير لون الخلفية له ونض

 back color  fill/ثم نختار

 
 

• “Create Form in Design View” 

نضغط    Design Viewبطريقة الـ    Formلإنشاء 

   Form Designثم   Createعلى تبويب 
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نموذج   نافذة  لنا  ستظهر 

 فارغ  

 

 

 

 

 

 

 

 

 

 

 

 

 

 يمكن تقسيم مساحة العمل في النموذج إلى ثلاثة أقسام 

1. Form Header  :-  ( يتم فيها طباعة عنوان النموذجForm  . الوقت والتاريخ , الصوت , ) 

2. Detail  :-  . يتم فيها سحب حقول الجدول 

3. Form Footer  :- . يتم فيها طباعة أدوات أخرى للنموذج 

 Form Header/Footerونختار   R.C لتقسيم مساحة العمل في النموذج إلى ثلاثة أقسام نضغط   
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   Tool Boxصندوق الأدوات  •
تضم مجموعة     Contentsسيظهر لنا مجموعة من الأدوات موجودة في الـ  Form Designمن تبويب  

 من الأشكال الصغيرة التي تسمى الأدوات كل أداة لها وظيفة معينة  

 

 

 

 

 -طريقة أختيار الأدوات :

 ( Formالضغط على أي أداة ثم سحبها بواسطة الماوس إلى أي مكان من النموذج )

 

 -:  Toolsالأدوات 

1. Label  :-   لكتابة عناوين مختلفة 
عند الضغط على هذه الأداة يتم تكوين مستطيل أو  

في العنوان    مربع  أو  النص  بداخله  نطبع  النموذج 

    Formالمراد عرضه في الـ  

طريق   عن  النص  على  تغييرات  إجراء  ونستطيع 

R.C    بلون خاصة  قائمة  لنا  تظهر  المستطيل  على 

 وحجم الخط وغيرها 

 

2. Text Box :-  

نضغط على الأداة الآتية  لإضافة صندوق نص  

بإدخال  النص  صندوق  لنا  يسمح  حيث 

الإسم والإيميل وغيرها    مثل  معلومات معينة 

 ويمكن التحكم أيضا في حجم ولون الخط 

3. Option Button  :-  
الشكل   في  كما  إختيارات  قائمة  لتكوين  يستخدم 

 الآتي 

 

Text Box 

Option 
Button 
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4. Image  :-   
لإضافة صورة نضغط على الأداة الآتية   

  ن الحاسبةونختار الصورة م

ــغط على الأداة   د الضــ   Imageعنـ

ــ   ستظهر لنا   Formورسم مربع داخل ال

ــبة  نافذة إخيار الصــورة من ملفات الحاس

بمجرد الضـــغط على الصـــورة المطلوبة  

سـتظهر لنا الصـورة داخل المربع كما في 

 -ة :النافذة الآتي

  

 

5. Link  :-  
  أو ملفات أخرى Webوهي الأداة التي تسمح لنا بربط النوذج بـقاعدة بيانات أخرى  أو رابط موقع   

 

ستظهر لنا بالشكل التالي حيث عند التنفيذ والضغط  

على الرابط يفتح الملف الذي قمت بربطه أو الموقع  

 الذي قمت بإضافته   Webصفحة الـ  

 

 

Image 

Link 
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6. List Box  :-  
 - تستخدم هذه الأداة لتكوين قائمة مفتوحة من حقول جدول معين وكما في الشكل :

  

       - الخيار الأول : •

تم إنشاءه  تكوين قائمة لجدول وحقول 

 Nextمسبقا  ثم نضغط  

 

 

 

 

 

نختار الجدول من هذه النافذة ثم نضغط  

Next 

 

 

 

 

 

 

نختار الحقول  من هذه النافذة ثم نضغط  

Next 

 

 

 

 

 

I want 
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تظهر لنا قائمة بهذا الشكل ثم نضغط  

Next  

 

 

 

 

 

 

 

تظهر لنا نافذة لتغيير إسم القائمة بهذا  

   Finishالشكل ثم نضغط  

  -نلاحظ أنها تظهر بالشكل التالي:

 

 

 

 

 

       - :  الخيار الثاني •

عن طريق إدخال  تكوين قائمة  

 Nextثم نضغط   بيانات جديدة 

 

 

 

 

 

 

 

I will 
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نقوم بإدخال بيانات العمود ثم نضغط  

Next 

 

 

 

 

 

 

نعطي عنوان العمود الذي تم إنشاءه ثم  

 Finishنضغط  

 - :تظهر لنا القائمة بهذا الشكل  

 

 

 

 

7. Combo Box  :-   

تستخدم هذه الأداة لتكوين قائمة منسدلة من حقول جدول معين  

 - وكما في الشكل : 

 كما في الشكل   List Boxويمكن إنشاءها بنفس طرق الـ  

 

 

8. Check Box  :-  

   ن خيار في نفس الوقتلإختيار أكثر مهذه الأداه في تسمح لنا 
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9. Option Group  :-   

 toggle buttons, option buttons, or checkنشئ إطارًا بحجم قابل للتعديل يمكنك من خلاله وضع 

boxes  بحيث واحد من هذه الخيارات فقط ممكن إضافته ضمن الإطار 

 

نعطي أسماء الخيارات ثم  

 Nextنضغط  

 

 

 

 

 

 

 

 

 

  Nextنحدد الإختيارالإقتراضي ثم  
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في هذه النافذة يطلب منا ترتيب أو  

 تسلسل 

 Nextالخيارات ثم نضغط  

 

 

 

 

 

 

 

 

هنا نختار نوع الأداة 

المطلوب وضعها ضمن الـ  

Option Group 
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 تظهر النافذة التالية     Optionومن إختيار أداة الـ  

 

 

 

10. Rectangle  :- 

شئ مستطيلاً يمكنك تغيير حجمه ونقله. يتم  ين 

تحديد لون الحدود والعرض ولون التعبئة للمستطيل  

 من خلال التحديدات من اللوحة. 
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11. Line  :-   

نشئ خطًا مستقيمًا يمكنك تغيير حجمه ونقله. يمكنك تغيير لون  

ام أزرار شريط أدوات التنسيق أو نافذة  الخط وعرضه باستخد

 الخصائص

 

12. Button  :-   

يمكن تقسيمها إلى  و، Command Buttonأزرار الأوامر  العديد من الأنواع المختلفة من  Accessيقدم 

 - فئات رئيسية:

 

Record Navigation : -  أزرار أوامر التنقل في السجل ، والتي تتيح للمستخدمين التنقل بين السجلات في

 قاعدة البيانات الخاصة بك 

Record Operation  :-م بأشياء مثل حفظ  أزرار أوامر عملية التسجيل ، والتي تتيح للمستخدمين القيا

 السجل وطباعته 

Form Operation  : -   أزرار أوامر عملية النموذج ، والتي تتيح للمستخدمين فتح نموذج أو إغلاقه بسرعة

 ، وطباعة النموذج الحالي ، وتنفيذ إجراءات أخرى 

Report Operation  :-   سريعة للقيام بأشياء  ، والتي توفر للمستخدمين طريقة  التقرير أزرار أوامر عملية

 مثل معاينة تقرير أو إرساله بالبريد من السجل الحالي 

 

 نتبع الخطوات في المثال التالي  Record Navigationلتنفيذ  

 

نسميه    Buttonثم نقوم بإضافة     Formلإنشاء    Form wizardمن الجدول السابق نضغط  

Search  
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تظهر لنا النافذة التالية ونحدد من  

خلالها الخيارات الموضحة بالشكل  ثم  

 Nextنضغط  

 

 

 

 

 

 

 

للبحث عن نص قي الـ    Textنختار 

Form      ثم نضغطNext 
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ثم نضغط    Buttonنعطي إسم للـ 

Finish  

 

 

 

 

 

 

 Searchنفتح النموذج في نافذة العرض أو التنفيذ ونضغط على زر  

معلومات موجودة في كل حقول النموذج  مثلا البحث عن إسم الطالب أو رقمه ستظهر لنا نافذة البحث عن 

 أو القسم أو درجته 

 Mustafaوإستبداله بإسم   Huseenويمكننا أيضا البحث عن مثلا إسم الطالب  وليكن  
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 ( Reportالتقرير  ) -13

 بطريقة  إنشاء التقرير •

تمنحك التقارير القدرة على تقديم مكونات قاعدة البيانات الخاصة بك بتنسيق سهل القراءة والطباعة.  

 إنشاء تقارير من الجداول والاستعلامات.  Access يتيح لك

 استخدامه في تقريرك.   ( افتح الجدول أو الاستعلام الذي تريد1)

 

 

 التقارير، ثم انقر فوق الأمر تقرير.  تبويب( حدد علامة التبويب إنشاء على الشريط. حدد موقع 2)

 

 
 

 بإنشاء تقرير جديد بناءً على الكائن الخاص بك.  Access ( سيقوم3)

الصفحة. لإصلاح هذا،  ( من المحتمل أن تكون بعض بياناتك موجودة على الجانب الآخر من فاصل 4)

قم بتغيير حجم الحقول الخاصة بك. ما عليك سوى تحديد حقل، ثم النقر على حافته وسحبها حتى يصبح  

 الخاصة بك.  يتم احتواء كل الحقول  الحقل بالحجم المطلوب. كرر ذلك مع حقول إضافية حتى

 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

46 
 

على شريط أدوات الوصول السريع.  اكتب اسمًا  ( لحفظ التقرير الخاص بك، انقر فوق الأمر حفظ  5)

 لتقريرك، ثم انقر فوق "موافق". 

 

 
 

 :حذف الحقول •

 يمكنك حذف الحقول في التقارير دون التأثير على الجدول أو الاستعلام  

( انقر فوق أي خلية في الحقل  1)               

الذي تريد حذفه، ثم اضغط على  

في لوحة   Delete مفتاح 

 المفاتيح. 

 

 

 

 
 

 ( سيتم حذف الحقل. 2)          

** عند حذف حقل، تأكد من حذف رأسه  

أيضًا. ما عليك سوى تحديد الرأس واضغط  

 على مفتاح الحذف. 
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 Report Wizardإنشاء التقرير بطريقة المعالج  •

 التقارير. انقر فوق أمر معالج التقارير.   تبويب حدد علامة التبويب "إنشاء" وحدد موقع  ( 1)

 

 
 

في    (2) التقارير  معالج  سيظهر 

الصفحات   سنناقش  أدناه،  الإجراءات 

 المختلفة في معالج التقارير. 

 

 
 

  

  

 

 

 

 تقرير   في إضافتها  المراد   الحقول  حدد  الأولى: الخطوة 

 

لتحديد  1) المنسدلة  القائمة  سهم  فوق  انقر   )

الحقل   الذي يحتوي على  الاستعلام  أو  الجدول 

 )الحقول( المطلوب. 
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القائمة الموجودة على  ( حدد حقلاً من 2)

اليسار، وانقر فوق السهم الأيمن لإضافته إلى  

 التقرير. 

 

 

 

 

 

 
 

من  3) أكثر  من  الحقول  إضافة  يمكنك   )

تكرار   طريق  عن  استعلام  أو  جدول 

إضافة   بعد  أعلاه.  المذكورة  الخطوات 

 الحقول المطلوبة، انقر فوق التالي. 

 

 

 

 

 

 :التقرير تنظيم  الثانية: الخطوة 

 سيوفر لك معالج التقارير خيارات تتيح لك اختيار كيفية عرض البيانات وتنظيمها.  

* إذا كنت تقوم بإنشاء تقرير من جدول أو استعلام واحد فقط، فيمكنك التخطي إلى الخطوة الثالثة  

 أدناه.
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سيقدم1)  ) Access   من بالعديد  خيارات  القائمة 

 لمعاينته.. حدد خيارًا من القائمة الجاهزة

 

 

 

 
 

 ( انقر فوق "التالي". 2)

 

 

حدد  3) التجميع.  مستويات  تعديل  الآن  يمكنك   )

الأيمن   السهم  فوق  وانقر  القائمة،  من  حقلاً 

 لإضافته كمستوى جديد.

 

 
 

 

 

 

الحقول  4) ترتيب  بتعديل  قم  الأمر،  لزم  إذا   )

فوق   والنقر  حقل  تحديد  طريق  عن  المجمعة 

أو   لأعلى  الأولوية  إلى  سهم  لتحريكه  لأسفل 

 مستوى أعلى أو أسفل. 

 

 

 

 ( انقر فوق "التالي". 5)
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 :بك الخاص  التقرير   بيانات  فرز الثالثة: الخطوة 

( انقر فوق السهم العلوي المنسدل، وحدد اسم  1)

 الحقل الأول الذي تريد فرزه. 

( انقر فوق الزر الموجود على اليمين لتغيير  2)

 تنازلي. الفرز إلى تصاعدي أو 

 

 
 

 ( انقر فوق "التالي". 3)

 

 

 :والعنوان التخطيط حدد  الرابعة: الخطوة 

 

التخطيط  1) خيارات  فوق  انقر   )

حدد     Layoutالمختلفة  ثم  مظهرها،  لرؤية 

  واحداً لاستخدامه في تقريرك.

 

 

 

 

 
 

أفقي  2) أو  )طويل(  عمودي  اتجاه  إما  حدد   )

 )عريض( لتقريرك. 

 

 

 

 

 "التالي". (  انقر فوق  3)
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تريده  4) الذي  العنوان  واكتب  النص،  ( حدد مربع 

 لتقريرك. 

( حدد ما إذا كنت تريد معاينة التقرير أو تعديل  5)

 تصميمه، ثم انقر فوق "إنهاء". 

 

 

 

 

 


